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Document History

Caution

Before you start the implementation, make sure you have the latest version of this document. You can find the

latest version at the following location: service.sap.com/instguides # .

The following table provides an overview of the most important document changes.

Table 1:
Version Date Description
1.2 2017-03-02 "SAP CRM" updated to "SAP Global
Trade Services" in the Interface Monitors
chapter
11 2015-07-17 e Report RSPPFCLEAN removed and
report /SCWM/PI_PERS_PPF_DEL
added to the Mandatory Scheduled
Periodic Tasks section
e Section Task Scheduling Tool modi-
fied
1.0 2015-05-28 Initial Version of the Application Opera-
tions Guide for SAP EWM 9.3
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2 Getting Started

Caution

This guide does not replace the daily operations handbook that we recommend customers create for their
specific production operations.

Designing, implementing, and running your SAP applications at peak performance 24 hours a day has never been
more vital for your business success than now.

This guide provides a starting point for managing your SAP applications and maintaining and running them
optimally. It contains specific information for various tasks and lists the tools that you can use to implement them.
This guide also provides references to the documentation required for these tasks, so you need other guides such
as the Master Guide, Technical Infrastructure Guide, and SAP Library.

2.1 Global Definitions

SAP Application:

An SAP application is an SAP software solution that serves a specific business area such as ERP, CRM, PLM, SRM,
or SCM.

Business Scenario:

From a microeconomic perspective, a business scenario is a cycle that consists of several different
interconnected logical processes in time. Typically, a business scenario includes several company departments
and involves other business partners. From a technical point of view, a business scenario needs at least one SAP
application (SAP ERP, SAP SCM, and so on) for each cycle and possibly other third-party systems. A business
scenario is a unit that can be implemented separately and reflects the customer’s prospective course of business.

Component:

A component is the smallest individual unit considered within the Solution Development Lifecycle; components
are separately produced, delivered, installed, and maintained.

SAP Extended Warehouse Management Operations Guide Release 9.3
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2.2 Important SAP Notes

Caution

Check regularly to see which SAP Notes are available for the Application Operations Guide.

Table 2: Important SAP Notes

SAP Note Number ‘ Title Comment

1515223 SAP NetWeaver Process Integration: Re- | Information about which Pl release to
lease Recommendation use

1721448 Py Service connection "SAPGui+Browser Remote log on for SAP Support
Connect."

812732/ R/3 Support service connection Remote log on for SAP Support when all

affected Uls are based on SAP GUI
1423066 M Optimization of the performance in EWM | N/A

2.3 Dock Appointment Scheduling

If you are using SAP Dock Appointment Scheduling without integration with SAP EWM, you need only refer to the
following sections of this document:

e Scheduled Periodic Tasks [page 22]

e Required Manual Periodic Tasks [page 26]

e Problem Message Handover [page 32]

SAP Extended Warehouse Management Operations Guide Release 9.3
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3 Technical System Landscape

3.1 Scenario/Component Matrix

For more information about the components necessary for business scenarios and processes, see the SAP EWM
Master Guide on SAP Service Marketplace at http://service.sap.com/instguides# |+ SAP Business Suite
Applications » SAP EWM » Using SAP EWM 9.3 1.

3.2 Related Documentation

1 Note

This Application Operations Guide only covers SAP EWM. If you run SAP EWM as part of an SAP SCM Server
installation, use the SAP SCM Operations Guide on SAP Service Marketplace at http://service.sap.com/

instguides#r | SAP Business Suite Applications » SAP SCM » SAP SCM Server » Using SAP enhancement
package 3 for SAP SCM 7.0 Server 3.

The following table lists where you can find more information about the technical system landscape.

Table 3:
Guide/Tool Quick Link on SAP Service Market-
place (service.sap.com)
Application-specific and Industry-spe- Master Guide instguides
cific Components such as SAP for Auto-
motive or SAP Retail
Technology Components such as SAP Master Guide instguides
NetWeaver
Sizing Quick Sizer Tool sizing
Technical Configuration Master Guide instguides
Scalability Master Guide instguides
High Availability Master Guide instguides
Security Security Map security
Application Security Guide instguides

SAP Extended Warehouse Management Operations Guide Release 9.3
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Guide/Tool Quick Link on SAP Service Market-

place (service.sap.com)

SAP NetWeaver Operations Operations Guides operationsnw74

For more information, go to www.service.sap.com#&, and | Products » SAP SCM » SAP SCM in Detail »
Warehousing ¥ Information on Extended Warehouse Management in SAP SCM » 07_Solution Manager Content,

EWM_910 3. The following documents provide additional information for the system setup and monitoring:

Table 4:
Guide ’ Link
ERP Integration Guide https://websmp207.sap-ag.de/~sapidb/

011000358700000102632013E/IntegrationERPEWM.pdf e

CRM Integration Guide

TM Integration Guide

SAP Extended Warehouse Management Operations Guide Release 9.3
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4 Monitoring of SAP EWM

Within the management of SAP technology, monitoring is an essential task. A section has therefore been devoted
solely to this subject.

You can find more information about the underlying technology in SAP Library for SAP NetWeaver under http://
help.sap.com/nw74#|p Technical Operations for SAP NetWeaver .

4.1 Alert Monitoring

Proactive, automated monitoring is the basis for ensuring reliable operations for your SAP system environment.
SAP provides you with the infrastructure and recommendations needed to set up your alert monitoring to
recognize critical situations for SAP EWM as quickly as possible.

4.1.1 Monitoring Installation and Setup

To enable the auto-alert mechanism of CCMS, see SAP Note 617547 #r .

You can find the EWM-relevant CCMS monitor sets in the EWM system in transaction CCMS Monitor Sets (Rz20).
Choose [F CCMS monitor sets » SAP EWM Monitor templates 3.

4.1.2 EWM-Specific Monitoring

SAP EWM provides the warehouse monitor as a central place to monitor your business processes from the
business and the technical perspective. You can start the monitor on the SAP Easy Access screen by choosing

|l SCM Extended Warehouse Management j Extended Warehouse Management ' Monitoring % Warehouse

Management Monitor 3 (transaction /scwM/MON). The following chapter will give you more detailed information.

4.2 Detailed Monitoring and Tools for Problem and
Performance Analysis

You can find more information about the underlying technology in SAP Library for SAP NetWeaver under http://

help.sap.com/nw74#| Technical Operations for SAP NetWeaver J and under SAP NetWeaver Process
Integration.

SAP Extended Warehouse Management Operations Guide Release 9.3
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4.2.1 Trace and Log Files

Trace files and log files are essential for analyzing problems.

The standard SAP NetWeaver tools such as transactions sT22 and sM21 can be used to monitor trace and log
files. For more information, see SAP Library for SAP NetWeaver at http://help.sap.com/nw74#% . In SAP Library,

choose ||» Technical Operations for SAP NetWeaver  English # Administration of Application Server ABAP

Monitoring and Administration Tools for Application Server ABAP 3.

Additionally, SAP EWM uses the application log (part of SAP NetWeaver) to store application error, warning, and
success messages issued in critical processes (for example, the delivery interface between SAP ERP and SAP
EWM) or in Ul transactions. For Ul transactions, the user has to save the application log explicitly.

For general information on application logs, see SAP Library for SAP NetWeaver at http://help.sap.com/nw74 .

In SAP Library, choose |r Function-Oriented View ¥ English ¥ Solution Life Cycle Management j» Application Log —

(BC-SRV-BAL) 3.

You can monitor the application logs with transaction SLG1 or in the Warehouse Management Monitor under

|» Tools » Application Log 3.

Table 5:

Log Object

Detailed Description

Activation/Deactivation

/SCWM/DLV_ERP

Delivery Processing: Stores error mes-
sages issued during the gqRFC communi-
cation of deliveries between SAP ERP
and SAP EWM with an expiry time of
seven days.

The system saves the log automatically
when the gRFC fails. If you need a log for
messages that were processed without
error for test purposes, , you can change
the settings in transaction /SCWM/

ERPLOG (|[# SAP Easy Access
Extended Warehouse Management >
Settings # Configure Log for ERP
Messages }).

/SCWM/ACC

Log for import of accounting objects
from SAP ERP

Log has to be saved explicitly in transac-

tion /scwm/acc 1Mp ERP (| SAP Easy
Access: Extended Warehouse

Management > Interfaces > ERP
Integration } Administration of Account

Assignment Data })

/SCMB/PATTERN UI

Log for Ul messages

Log has to be saved explicitly in the SAP
EWM Ul transactions.

10 CUSTOMER
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Log Object Detailed Description
/SCWM/WME Warehouse Logistics Processing: Log for
SAP EWM operations

Activation/Deactivation

Log has to be activated with transac-

tion /scwm/acTLOG ([ SAP Easy
Access: Extended Warehouse

Management > Settings > Activate
Application Log )

You can activate the application log on
subobject level.

/SCWM/SHP_RCV Site Logistic Processing: Log for ship-
ping and receiving transactions

/SCWM/EPD Labor Management: Log for sending per-
formance documents to HR

Log has to be saved explicitly by the
user in transaction /scum/

EPD_TRANSFER (| SAP Easy Access:
Extended Warehouse Management p
Labor Management > Employee
Performance > Send Performance

Document to HR ])

/SCMB/MD Master Data: Log for deleting supply -
chain units
/SCWM/PACKSPEC Master Data: Log for packaging specifi- | The log for the determination analysis
cations has to be activated in transaction /
SCWM/PSLOG. The log for uploading
packaging specifications has to be
saved explicitly by the user in transac-
tion /scuM/1PU (| SAP Easy Access:
SCM Basis » Master Data j» Packaging
Specification > Initial Data Transfer of
Packaging Specifications |
/SEHS/ALE EH&S Master Data: log for importing -

master data (dangerous goods, hazard-
ous substances and phrases)

/SCTM/TM Transportation Management

SAP Extended Warehouse Management Operations Guide Release 9.3
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Log Object Detailed Description Activation/Deactivation

PPF Post Processing Framework The log is always active. You can deacti-
vate the log for delivery processing in

transaction /scwmM/DLVPPFLOG (|F SAP
Easy Access: Extended Warehouse

Management p Delivery Processing >
Actions > Deactivate PPF Log
Depending on Warehouse and User })

/SCMB/RG Routing Guide -
/SCWM/CHM EWM Check Monitor -
/SCWM/DAS Dock Appointment Scheduling The log is used for asynchronous proc-

esses and reports in Dock Appointment
Scheduling. By default it is written for
errors and warnings.

You can change the activation of the log
in transaction /SCwM/DSLOG.

During the implementation and test phase, or when you need to investigate an issue, you should activate the
related logs. Once the system is running smoothly, you can improve the performance if you configure the logs to
record only Important or Very Important messages or deactivate them completely.

For descriptions of the recommended tasks to contain data growth, see Periodic Tasks [page 21].

4.2.2 Workload Monitors

SAP Extended Warehouse Management uses the standard tools available in SAP NetWeaver and does not require
a component-specific tool. For more information, see SAP Library for SAP NetWeaver under http://

help.sap.com/nw74#%| Technical Operations for SAP NetWeaver 3.

4.2.3 Other Important Problem Analysis and Monitoring Tools

SAP Extended Warehouse Management uses the standard tools available in SAP NetWeaver and does not require
a component-specific tool. For more information, see SAP Library for SAP NetWeaver under http://

help.sap.com/nw74#% | Technical Operations for SAP NetWeaver 3.

SAP Extended Warehouse Management Operations Guide Release 9.3
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4.2.4 Interface Monitors

Interface monitors are essential for analyzing problems with interfaces such as RFC, IDoc, and HTTP.

Table 6:

Interface

Delivery Processing

Description

SAP ERP and SAP EWM

Communication based on ERP deliver-
ies/ EWM warehouse requests as foun-
dation for logistics execution in EWM

Relevant for all systems with integration
to SAP ERP

Technology Used

gRFC

Goods Movement

SAP ERP and SAP EWM

Goods movements that are not directly
related to an ERP delivery document

Relevant for all systems with integration
to SAP ERP

gRFC

Distribution of master data

SAP ERP and SAP EWM

Relevant for all systems with integration
to SAP ERP

gRFC

Bl Data Sources

SAP BW and SAP EWM

Transportation Integration (ERP)

SAP ERP and SAP EWM

Communication based on ERP shipment
(including ERP Shipment created by SAP
TM)/ EWM transportation unit

Optional business process

IDoc

Transportation Integration (TM)

SAP ERP and SAP TM
Web Services

Optional business process

X+ WEBservice

Warehouse Billing

SAPTM
Web Services

Optional business process

Xl + WEBservice

Quality Inspection

SAP ERP and SAP EWM

Integration of quality inspection in SAP
ERP and SAP EWM

Optional business process

qRFC

SAP Extended Warehouse Management Operations Guide Release 9.3
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Interface

Global Trade Compliance Check

Description

SAP Global Trade Services and SAP

EWM

Optional business process

RFC, gRFC

Technology Used

Material Flow System

Yard Management

Web Services for Non-SAP systems

Optional interface

Xl + WEBservice

Delivery Notifications

Web Services for Non-SAP systems

Optional interface

XI + WEBservice

Transportation Integration with external
planning system

Integration with Non-SAP systems

Optional interface

IDoc

Monitor tools for these interfaces are:

Table 7:
Interface Monitor
Delivery Processing SMQ1/ SMQ2

Description

Standard gRFC monitoring as
described in the application
help for SAP NetWeaver

Queues beginning with DLVS,
DLWS

The queue on the ERP side
should be monitored within
one month as a goods move-
ment can only be posted in
the current and previous pe-
riod (for example, a goods
movement sent to the queue
on July 15 must be posted on
August 31 at the latest)

Prerequisites

Create settings for qRFC
scheduling and administra-
tion in transactions SMQE,
SMQS and SMQR as descri-
bed in the Integration Guide

14 CUSTOMER
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Interface Monitor Description Prerequisites
Goods Movement SMQ1/ SMQ2 Standard gRFC monitoring as | Create settings for gRFC
described in the application scheduling and administra-
help for SAP NetWeaver tion in transactions SMQE,
SMQS and SMQR as d i-
Queues beginning with EWM- b dg :hn nt Q :S ZST
GOODSMVT. WMPGR, ed in the Integration Guide
WMPGI SeeFor the monitor-
ing of queues in SAP ERP.
For the monitoring of queues
in SAP ERP see Delivery Proc-
essing
Production (Production Mate- | SMQ1/ SMQ2 Standard gRFC monitoring as | Create settings for gRFC
rial Request) described in the application scheduling and administra-
help for SAP NetWeaver tion in transactions SMQE,
SMQS and SMQR as d i-
Queues beginning with PR Q an Q és eS(.ZI’I
bed in the Integration Guide
(see chapter 2.2)
Distribution of master data SMQ1/ SMQ2 Standard gRFC monitoring as | Create settings for gRFC
described in the application scheduling and administra-
help for SAP NetWeaver tion in transactions SMQE,
SMQS and SMQR as descri-
Queues beginning with CF, PS Q Q ] ] !
bed in the Integration Guide
Bl Data Sources SMQ1/ SMQ2 Standard gRFC monitoring as

described in the application
help for SAP NetWeaver

Queues beginning with
WMBB, WMDB, WMTB,
WMOB, WMVB

Transportation Integration
(ERP)

WEINQUEUE/ WEOUTQUEUE

Standard IDoc monitoring as
described in the application
help for SAP NetWeaver

IDocs SHPMTO5, SHPMTO6

Transportation Integration SXMB_MONI Standard XI monitoring as de-

(TM) scribed in the application help
for SAP NetWeaver

Warehouse Billing SXMB_MON!I Standard XI monitoring as de-

scribed in the application help
for SAP NetWeaver

SAP Extended Warehouse Management Operations Guide Release 9.3
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Interface

Monitor

Description

Prerequisites

Quality Inspection

SMQL/ SMQ2

SWEQADM, SWETYPV,
SWELS

Standard gRFC monitoring as
described in the application
help for SAP NetWeaver

Create settings for gRFC
scheduling and administra-
tion in transactions SMQE,

SMQS and SMQR as descri-

Queues beginning with ) ] )
bed in the Integration Guide

QI,DLVS, DLWS, EWMSQPO

Material Flow System /SCWM/MON, node Communication between -

|} Material Flow System > EWMand PLC
Telegram Buffer 3
Yard Management SXMB_MONI Standard XI monitoring as de- | -
scribed in the application help
for SAP NetWeaver
Delivery Notifications SXMB_MONI Standard XI monitoring as de- | -

scribed in the application help
for SAP NetWeaver

Transportation Integration WEINQUEUE/ WEOUTQUEUE

Standard IDoc monitoring as
with external planning system described in the application

help for SAP NetWeaver

IDocs TMSHPO1, TMFRD2

= Recommendation

As an alternative to the technical monitoring, you can monitor the gRFC messages between SAP EWM and SAP
ERP in a business context. In the EWM monitor (transaction /ScwM/MON) under node |+ Tools » Message
Queue Jyou can get a list of EWM-relevant queues in the EWM and ERP systems. The system enriches the list
with relevant information for a business user such as the warehouse number and texts. You can use this
additional option for monitoring queues without additional configuration, but you can also adapt the selection
to the needs of your users in Customizing for Extended Warehouse Management under [ Monitoring »
Message Queue Monitoring 4.

SAP EWM uses the gRFC for internal messages to achieve minimal response time for users who need to work
with a high throughput. These queues also need to be monitored. You can do the monitoring as described for
the interfaces above, using transaction sMQ2/sMQ1 for queues starting with wM, EwM, or DLV. Alternatively, you
can use the EWM monitor to display the queues with additional business data as described above.

4.2.5 Data Growth and Data Archiving Monitors

SAP Extended Warehouse Management uses the standard tools available in SAP NetWeaver and does not require
a component-specific tool. For more information, see the SAP NetWeaver Operations Guide on SAP Service
Marketplace at http://service.sap.com/operationsnw74 .

SAP Extended Warehouse Management Operations Guide Release 9.3
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You can archive the following data in SAP EWM:

Table &:

Application Component

Business Object/ Document
Category

Archiving Object

Re-Schedule Report After
Upgrade to EWM 9.3*

Delivery Processing Internal Warehouse Requests | DLV_INB
(Inbound Delivery)
Internal Warehouse Requests | DLV_OUT
(Outbound Delivery)
Warehouse Requests from DLV_REQ
External Systems
Stock Management Handling Unit WME_HU
Warehouse Logistic Process- | Warehouse Tasks and Goods | WME_TO
ing Movement Documents
Warehouse Orders WME_WO
Waves WME_WAVE
Telegram Flows WME_MFS
Relevant Resource Data WME RSRC
Value-Added Service Orders | WME_VAS
(VAS Orders)
QIE Inspection Documents QIE_INSP
Physical Inventory Docu- LIME PI
ments
LIME Log Entries (goods LIME NLOG
movements and confirmed
warehouse tasks). Periodicity
analogous to WME_TO
Site Logistic Processing Door Activities WME DOOR
Vehicle Activities WME_VEH
Transport Unit Activities WME_TU
Labor Management Indirect Labor Tasks WME ILT
Executed Workloads WME_EWL
Employee Performance Docu- | WME_EPD

ments

SAP Extended Warehouse Management Operations Guide Release 9.3
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Application Component Business Object/ Document | Archiving Object Re-Schedule Report After
Category Upgrade to EWM 9.3*
Business Partners (Process- | CA_BUPA
ors) — only if created origi-
nally in SAP EWM

Transportation Management | Shipments TM SHP

inEWM
Freight Documents TM_FRD

Warehouse Billing EWM Warehouse Billing EWM_WBM

Measurements

Caution

The archiving reports for the archiving objects marked with * were improved in EWM 9.3. After an upgrade
from EWM 9.2 or lower to EWM 9.3 you have to adapt your existing background jobs for those archiving objects

with new variants.

The affected reports are:

Archiving Object Report WME_TO WME_ARCH_TO_WRITE WME_WO WME_ARCH_WO_WRITE WME_WAVE
WME_ARCH_WAVE_WRITE WME_MFS WME_ARCH_MFS_DELETE WME_ARCH_MFS_WRITE WME_RSRC
WME_ARCH_RSRC_WRITE WME_TU WME_ARCH_TU_MARK WME_ARCH_TU_WRITE WME_VEH
WME_ARCH_VEH_MARK WME_ARCH_VEH_WRITE WME_DOOR WME_ARCH_DOOR_MARK
WME_ARCH_DOOR_WRITE DLV_INB /SCDL/DLV_INB_ARCH_WRITE DLV_OUT /SCDL/
DLV_OUT_ARCH_WRITE DLV_REQ /SCDL/DLV_REQ_ARCH_WRITE WME_VAS WME_ARCH_VAS_WRITE
WME_EPD /SCWM/EPD_ARCH_WRITE WME_EWL /SCWM/EWL_ARCH_WRITE WME_ILT

WME_ARCH_ILT_WRITE

Table 9:
Archiving Object Report
WME_TO WME_ARCH_TO_WRITE
WME_WO WME_ARCH_WO_WRITE
WME_WAVE WME_ARCH_WAVE_WRITE
WME_MFS WME_ARCH_MFS_DELETE
WME_ARCH_MFS_WRITE
WME_RSRC WME_ARCH_RSRC_WRITE
WME_TU WME_ARCH_TU_MARK
WME_ARCH_TU_WRITE
WME_VEH WME_ARCH_VEH_MARK
SAP Extended Warehouse Management Operations Guide Release 9.3
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WME_ARCH_VEH_WRITE

WME_DOOR WME_ARCH_DOOR_MARK

WME_ARCH_DOOR_WRITE

DLV_INB /SCDL/DLV_INB_ARCH_WRITE
DLV_OUT /SCDL/DLV_OUT_ARCH_WRITE
DLV_REQ /SCDL/DLV_REQ_ARCH_WRITE
WME_VAS WME_ARCH_VAS_WRITE
WME_EPD /SCWM/EPD_ARCH_WRITE

1 Note

Replicated master data (for example, products, locations, supply chain units, business partners, and batch
data) does not have to be archived in SAP EWM. Master data is deleted by the solution (for example SAP ERP
or SAP CRM) in which it was originally created.

Caution

SAP EWM also creates data that is not subject to archiving. Make sure to schedule periodic deletion jobs as
described in Periodic Tasks [page 21], to control data growth and to ensure the performance of your EWM
system.

4.3 Data Consistency

SAP EWM exchanges data with SAP ERP using asynchronous messages. Monitor the gRFC messages in the EWM
and in the ERP system as described in Interface Monitors [page 13].

You can check the consistency of your EWM system using the transaction /scwM/CcHM PRF (Maintain Check
Monitor Profile). The particular checks are documented in the transaction.

SAP Extended Warehouse Management Operations Guide Release 9.3
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5 Management of SAP EWM

SAP provides you with an infrastructure to help your technical support consultants and system administrators
effectively manage all SAP components and complete all tasks related to technical administration and operation.
For more information on the underlying technology, see SAP Library for SAP NetWeaver under http://
help.sap.com/nw74#| Technical Operations for SAP NetWeaver 1.

5.1 Starting and Stopping

SAP EWM is provided either as a standalone component on SAP NetWeaver, as part of SAP SCM or as an add-on
to SAP ERP.

e SAPEWM as a standalone component on SAP NetWeaver is started/stopped together with SAP NetWeaver.
For more information about STARTSAP/STOPSAP and SAPMMC, see SAP Library for SAP NetWeaver on SAP
Help Portal at http://help.sap.com/nw74#% . In SAP Library, choose [ Function-Oriented View » English »
Solution Life Cycle Management » Starting and Stopping SAP NetWeaver ABAP and Java .

e SAPEWM as part of SAP SCM: SAP EWM is started/stopped together with the SCM Server (STARTSAP/
STOPSAP). For more information, see SAP Service Marketplace at http://service.sap.com/instguides
| SAP Business Suite Applications » SAP SCM » SAP SCM Server ¥ Using SAP enhancement package 3 for
SAP SCM Server 7.0 ¥ Application Operations Guide for EHP3 for SAP SCM 7.0 1.

e SAPEWM as an add-on to SAP ERP: SAP EWM is started/stopped together with SAP ERP (STARTSAP/
STOPSAP). For more information, see SAP Service Marketplace at http://service.sap.com/instguides
| SAP Business Suite Applications  SAP ERP » SAP ERP 6.0 » SAP enhancement packages for SAP ERP 6.0
» SAP enhancement package 7 for SAP ERP 6.0 » EHP 7 for SAP ERP 6.0 — Operations Guide 3.

In all cases, we recommend that you start the interface components CIF and SAP XI (if used) after starting SAP
EWM and that you stop them before stopping SAP EWM.

For more information about the components necessary for business scenarios and processes, see the SAP EWM
Master Guide on SAP Service Marketplace at http://service.sap.com/instguides#|p SAP Business Suite
Applications » SAP EWM » Using SAP EWM 9.3 3.

5.2 Software Configuration

This section explains which components or scenarios used by this application are configurable and which tools
are available for adjusting.

All technical configuration that is required for running SAP EWM is part of SAP NetWeaver. For information about
the relevant technical configuration, see SAP Library for SAP NetWeaver on SAP Help Portal at http://
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help.sap.com/nw74#% . In SAP Library, choose [ Function-Oriented View » English » Solution Life Cycle
Management » Configuring SAP NetWeaver 3.

5.3 Administration Tools

SAP Extended Warehouse Management and the underlying components are all technically based on SAP
NetWeaver. For information about the relevant administration tools, see SAP Library for SAP NetWeaver under

http://help.sap.com/nw74#& ¢ Technical Operations for SAP NetWeaver 1.

5.4 Backup and Restore

You need to back up your system landscape regularly to ensure that you can restore and recover it in case of
failure.

The backup and restore strategy for the application consists of the following:

e Backup and restore coverage for each component

e Cross-system data dependencies and handling
The backup and restore strategy for your system landscape must not only consider SAP systems but must also
be embedded in the overall business requirements and incorporate your company’s entire process flow. In
addition, the backup and restore strategy must cover disaster recovery processes, such as the loss of a data

center through fire. In this context, it is essential that you ensure that backup devices are not lost together with
normal data storage, by using separate storage locations.

SAP EWM 9.3 is based on SAP NetWeaver technology. All related SAP NetWeaver backup procedures also work
for SAP EWM. Therefore, there is no special procedure for SAP EWM 9.3. For more information on backup and
recovery see http://help.sap.com/nw74#& ¢ System Administration and Maintenance Information » Operations

Information 3. If you need to recover your system you can check the consistency with the ERP system after the
recovery as described in Data Consistency [page 19].

5.5 Periodic Tasks

5.6 Periodic Tasks

In addition to the standard jobs mentioned in Technical Operations for SAP NetWeaver in SAP Library, you must
schedule SAP EWM-specific jobs in your SAP system.

All jobs, unless otherwise specified, must be run at times of minimal system activity, so as not to affect
performance or otherwise disrupt your daily operations. All jobs can be restarted.
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5.6.1 Scheduled Periodic Tasks

This section describes all tasks that can be automated and that must be run periodically to keep the application
running smoothly. Such tasks may be required on component level and are, therefore, relevant in each scenario
that uses the component. Other tasks may be relevant for certain business scenarios only. It is important that you
monitor the successful execution of these tasks on a regular basis.

For more information about the components necessary for business scenarios and processes, see the SAP EWM

Master Guide on SAP Service Marketplace at http://service.sap.com/instguides# |+ SAP Business Suite
Applications » SAP SCM ¥ SAP EWM ¥ Using SAPEWM 9.3 1.

Table 10: Scheduled Periodic Tasks for SAP EWM

Program Name/Task

Task Scheduling Tool

Recommended Frequency

Detailed Description

Transaction SARA

Transaction SARA and
Definition of Back-
ground Jobs

Depends on the archiving object and
the DB growth

Archiving of archiving objects men-
tioned in Data Growth and Data Ar-
chiving Monitors [page 16]

Caution

Caution: After the upgrade to
EWM 9.3 the jobs that you have
scheduled before the upgrade will
not work anymore. You have to
schedule them again. For further
information see chapter 3.2.5

RSPPF_SWJCLEAN

ground Jobs

Transaction s1.G2 (re- | Definition of Back- Weekly/monthly Deletion of application logs descri-
port SBAL DELETE) ground Jobs bed in Trace and Log Files [page 10]
Report Definition of Back- Weekly/monthly Deletion of technical data from PPF

actions. See note 1890845 Fr .

Report /scwm/
PI_PERS PPF DEL

Periodicity analogous to archiving
periods of the physical inventory
documents

Warehouse Logistic Processing: De-
letes SAP EWM-specific PPF action
data
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Program Name/Task

Task Scheduling Tool

Recommended Frequency

Detailed Description

Report /L.1ME/
COLLECTION DELETE

Periodicity analogous to archiving
periods of the confirmed warehouse

Warehouse Logistics Processing: De-
letes the dispatch message log for

BACKGROUND__
DELETE EXEC

To delete zero quantities, set no
other parameter.

tasks goods movements between SAP
EWM and SAP ERP.
® Planning System
® Business Warehouse
® Financial System
® |nventory System
® f[xternal System
e R/3Inventory Mngmt
* GlLW2IM:X
e  Minimum Age in Days
e End Date of Deletion Run:
fill in actual date
All processed records will be deleted
Report /LIME/ - Weekly/monthly Inventory: Deletes DB entries for

zero stock quantities and - on re-
quest — index entries without stock.
SAP EWM index tables: /scwmM/
STOCK_IW01l, IW02, IW03 and
_IW04

The index table entries are only de-
leted if this is allowed in Customizing.
For more information, see Customiz-

ing for SAP EWM under |} SCM Basis
> Logistics Inventory Management
Engine (LIME) ¥ Basic Settings
Index Tables and Hierarchy

Determine Index Tables }

Report /scwm/
R _REORG_
HU WO_PRINT

Periodicity analogous to archiving
periods of the warehouse tasks

Warehouse Logistic Processing: De-
letes SAP EWM-specific PPF action
data

ALEN_ALERT_ DELETE

Report /sapapo/ - Monthly Master data: Deletes products with
DELETE PRODUCTS deletion flag

Report /saparo/ - Yearly Master data: Deletes locations with
DELETE LOCATIONS deletion flag

Report /scMB/ - Weekly/monthly Deletes alerts older than x days
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Program Name/Task

Task Scheduling Tool

Recommended Frequency

Detailed Description

Report /scwM/R _MS
RESULT DELETE

Depends on the usage of Measure-
ment Services

Labor Management (Analytics): De-
letes Measurement Service Results
(SAP Easy Access screen

|} Extended Warehouse
Management > Settings >

Measurement Services > Periodic

R_PDO COMPLETE

Processing })

Report /scTm/ - Monthly Master data: Deletes routes with de-

DELETE ROUTE letion flag

Report /scT™M/ - Monthly Master data: Deletes transportation

DELETE ZONE zones with deletion flag

Report /scTm/ - Yearly Freight order processing: deletes the

CLEANUP_ PPF PPF actions without corresponding
business objects (actions to publish
the deletion of the objects)

Transaction /scwM/ - Determines and sets prices from

VALUATION SET SAP ERP

Report /scwm/ - Transfers extracted data from gRCF-

R BW COLLECTIVE R Queue WMTB (warehouse task),

UN WMOB (warehouse order), WMBB
(storage bin), WMDB (delivery item),
or WMVB (Value Added Service) to
the Bl Delta Queue.

Report /scwM/ - Posts differences (for example,

R WM ADJUST warehouse task differences) to the
SAP ERP system

Report /scwm/ - Deletes old DAS time slots and ap-

R DAS DELETE pointments

Report /scwm/ - Daily Completes outbound delivery order

items with zero quantity

Table 11: Scenario-Specific Scheduled Periodic Tasks

Required for Scenario(s)

Program Name/Task

Recommended Frequency

Description

Dock Appointment Schedul- | Report /scwM/ Monthly Deletes old DAS time slots
ing R DAS DELETE and appointments
SAP Extended Warehouse Management Operations Guide Release 9.3
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Required for Scenario(s)

Program Name/Task

Recommended Frequency

Description

Proof-of-Delivery Report /scwM/RPOD _IMP Op- | Daily Imports POD data from ERP
tion Create
Proof-of-Delivery Report /scwM/RPOD_IMP Op- | Monthly Deletes POD data

tion Delete

Cartonization Planning

Transaction /SCWM/CAPDEL

Depends on how often plan-
ned shipping HUs are used in
the outbound process.

Weekly, monthly or yearly.

For goods issue posted out-
bound delivery orders the
planned shipping can be de-
leted. Alternatively you can
also delete PSHUs before
wave creation with the re-
port /scwM/

R_WAVE_PLAN BACKGROUND.
To do so, select the checkbox
Delete Planned Shipping HUs
of the report.

Labor Management

Report /SCWM/R MS
RESULT DELETE

Depends on the usage of
Measurement Services

Labor Management (Analyt-
ics): Deletes Measurement
Service Results (SAP Easy

Access screen |} Extended
Warehouse Management >
Settings 1 Measurement
Services > Periodic

Processing 1)

Labor Management

Report /scwm/
R _REORG_LDP_HIST

Depends on the amount of
data needed for Labor De-
mand Planning Forecast and
the DB growth

Deletion of historical work-
load data

Transportation Integration Report RBDMANTI2 Hourly Processing of Idocs which are
(ERP) not yet posted
Transportation Management | Report /SCTM/CLEANUP PPF | Yearly Freight order processing: de-
in EWM letes the PPF actions without
corresponding business ob-
jects (actions to publish the
deletion of the objects)
Transit Warehouse Report /scwm/ Monthly HU Processing in transit

R _REORG HU TW PPF

warehouse: Deletes SAP
EWM-specific PPF action data
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Required for Scenario(s)

Program Name/Task

Recommended Frequency

Description

Delayed completion of in-
bound deliveries

Report /scwm/
R DELETE DWM VARI

Daily

Deletes obsolete variants for
report /SCWM/
R_PRDI_SET_DWM. When
you schedule the job, ensure
that the job to reorganize the
background jobs
(RSBTCDELZ2) deleted the
corresponding job logs.

Warehouse Billing

Report /scwm/
WB_SNAPSHOT DELETION

Monthly

Delete Obsolete Snapshot
data

Warehouse Billing

Report /scwMm/
WB_WBMR_DELETION

Yearly

Delete obsolete request for
warehouse billing measure-
ment and specifications of
warehouse billing measure-
ment

Transit Warehouse

Report /scwM/
R REORG HU TW PPF

Monthly

HU Processing in transit
warehouse: Deletes SAP
EWM-specific PPF action data

5.6.2 Required Manual Periodic Tasks

This section describes all manual tasks required to run periodically in order to keep the application running
smoothly over time. A manual task needs a user to execute each task, as opposed to the scheduled tasks listed
above which can be automated using a task scheduler program. Such tasks may be required on component level
and are therefore relevant in each scenario that uses the component. Other tasks may be relevant for certain
business scenarios only. It is important that you monitor the successful execution of these tasks on a regular

basis.

Table 12: Scenario-Specific Manual Tasks

Required for Scenario(s)

Tool(s) Supporting this Task | Recommended Frequency

Description

Dock Appointment Schedul-

ing

Web Dynpro Application /
SCWM/DSSLOT_GEN

Depends on the usage of time

slots in Dock Appointment
Scheduling (DAS)

Weekly or monthly

For the creation of time slots
in the graphical view of Dock
Appointment Scheduling

5.7 Load Balancing

SAP Extended Warehouse Management uses standard SAP NetWeaver functions for logon and load balancing.
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For more information, see SAP Library for SAP NetWeaver on SAP Help Portal at http://help.sap.com/nw74#r .
In SAP Library, choose | Function-Oriented View # English » Solution Life Cycle Management » SAP Business
Continuity 3.

For more information, see SAP Library for SAP NetWeaver under http://help.sap.com/nw74#& |y Technical
Operations for SAP NetWeaver J.

5.8 Management of Outdated Technical Data

The deletion of technical data is included in Scheduled Periodic Tasks [page 22].

5.9 Scenario Administration Concept

SAP EWM uses standard SAP NetWeaver functions. There are no specifics for administration in EWM scenarios.
The behavior of EWM in different deployment options for starting and stopping the system is described in Starting
and Stopping [page 20].
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6 High Availability

SAP EWM uses standard SAP NetWeaver functions for high availability.

For more information about high availability, see SAP Library for SAP NetWeaver on SAP Help Portal at http://
help.sap.com/nw74#% . In SAP Library, choose | Function-Oriented View » English » Solution Life Cycle
Management » SAP Business Continuity 3.

SAP Extended Warehouse Management Operations Guide Release 9.3
28 CUSTOMER High Availability


http://help.sap.com/disclaimer?site=http://help.sap.com/nw74
http://help.sap.com/disclaimer?site=http://help.sap.com/nw74

7 Software Change Management

Software Change Management standardizes and automates software distribution, maintenance, and testing
procedures for complex software landscapes and multiple software development platforms. These functions
support your project teams, development teams, and application support teams.

The goal of Software Change Management is to establish consistent, solution-wide change management that
allows for specific maintenance procedures, global rollouts (including localizations), and open integration with
third-party products.

This section provides additional information about the most important software components for SAP EWM.

7.1 Transport and Change Management

For transport and change management issues, the procedures of SAP NetWeaver apply for SAP EWM. For more
information, see SAP Library for SAP NetWeaver on SAP Help Portal at http://help.sap.com/nw74 . In SAP

Library, choose |* Technical Operations for SAP NetWeaver  English » Administration of Application Server ABAP
» Change and Transport System 4.

You can use SAP EWM with multiple clients. This is a useful option for test systems if you want to test different
warehouse-independent settings in parallel. For your production system you must ensure that the sizing of your
system is sufficient for all warehouses on all clients.

If you are using multiple clients and BAdI filters in your EWM system, you must ensure that the filter values are
disjunctive for all clients.

7.2 Development Requests and Development Release
Management

SAP EWM uses standard SAP NetWeaver procedures. For more information, see SAP Library for SAP NetWeaver
under http://help.sap.com/nw74#|» Technical Operations for SAP NetWeaver 3.

7.3 Support Packages and Patch Implementation

We recommend that you implement Support Package Stacks (SP Stacks), which are sets of Support Packages
and patches for the respective product version that must be used in the given combination. The technology for
applying Support Packages and patches will not change.
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For more information about the availability of SP Stacks, see SAP Service MarketPlace at http://
service.sap.com/sp-stacks .

Read the corresponding Release and Information Notes (RIN) before you apply any Support Packages or patches
of the selected SP Stack.

The RIN and Support Packages for SAP EWM are available on SAP Service Marketplace at http://
service.sap.com/patchest. Use the search function to find SAP EWM 9. 3.

Use the Maintenance Optimizer (transaction Dswp) in SAP Solution Manager to select, download, and install the
required software layers, or software components and required Support Packages. For more information, see the
following:
e SAP Library for SAP Solution Manager on SAP Help Portal at http://help.sap.com/solutionmanager# . In
SAP Library, choose [ Change Request Management and Change Control » Maintenance Optimizer 3.
e SAP Service Marketplace at http://service.sap.com/solman-mopz#
® The documentation for transaction SAINT (SAP Add-On Installation Tool)

For more information about implementing Support Packages as well as possible side effects, see http://
service.sap.com/patches# |+ SAP Support Packages in Detail 4.

For more information about the tools necessary for implementing patches, see SAP Library for SAP NetWeaver
on SAP Help Portal at http://help.sap.com/nw74#% . In SAP Library, choose |» Technical Operations for SAP
NetWeaver » English » Administration of Application Server ABAP 3.
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8 Troubleshooting

For information about troubleshooting SAP NetWeaver, see SAP Library for SAP NetWeaver under http://
help.sap.com/nw74#%|» Technical Operations for SAP NetWeaver 3.
The following tools are available for troubleshooting SAP EWM:
e Application logs
For more information, see Trace and Log Files [page 10].
o \Where-used list
The where-used list informs you about where a product is used in SAP EWM. This enables you, for example, to
determine whether a product is still used in a document and to identify inconsistencies in the product data.
For more information, see SAP Library for SAP EWM on SAP Help Portal at http://help.sap.com/ewm#& and
choose the relevant release. In SAP Library, choose |# SCM Basis » SCM Basis Master Data » General Master

Data Functions ¥ Deleting Master Data » Where-Used List for Master Data 3.
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9 Support Desk Management

Support Desk Management enables you to set up an efficient internal support desk for your support organization
that seamlessly integrates your end users, internal support employees, partners, and SAP Active Global Support
specialists with an efficient problem resolution procedure.

For support desk management, you need the methodology, management procedures, and tools infrastructure to
run your internal support organization efficiently.

9.1 Remote Support Setup

SAP support must be able to work remotely for highest efficiency and availability and, therefore, requires remote
access to all necessary support tools. For SAP EWM, the standard SAP procedures for setting up remote support

apply.

For information about Remote Support Setup, see SAP Service Marketplace at http://service.sap.com/access-
support#.

9.2 Problem Message Handover

To send problem messages or tickets to SAP, choose the appropriate component (or subcomponent) name from
the SAP component hierarchy:

Table 13:
Component Description
SCM EWM Extended Warehouse Management
SCM-EWM-ANA Analytics
SCM-EWM-ARC Archiving
SCM-EWM-AUT Authorization
SCM-EWM-CD Cross-Docking
SCM-EWM-CAP Cartonization Planning
SCM-EWM-DLP Delivery Processing
SCM-EWM-DAS Dock Appointment Scheduling
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Component Description

SCM-EWM-EH Exception Handling
SCM-EWM-GM Goods Movements
SCM-EWM-IF Interfaces

SCM-EWM-LM Labor Management
SCM-EWM-MD Master Data

SCM-EWM-MD Fulfillment Coordination
SCM-EWM-MFS Material Flow System
SCM-EWM-MON Monitoring

SCM-EWM-PI Physical Inventory
SCM-EWM-PRC Preconfigured Processes
SCM-EWM-PRN Printing

SCM-EWM-QM Quality Management
SCM-EWM-RF Radio Frequency Processing
SCM-EWM-RG Routing Guide
SCM-EWM-SR Shipping and Receiving
SCM-EWM-TM Transportation Management
SCM-EWM-UIF User Interface Framework
SCM-EWM-VAS Value Added Services
SCM-EWM-WAV Wave Management
SCM-EWM-WC Work Center
SCM-EWM-WOP Warehouse Order Processing

For information about safeguarding, see http://service.sap.com/safeguarding#r .

= Recommendation

When you send a message to SAP for one of the EWM components, always provide the warehouse number
together with the technical key (document number) in the description.
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If you want to use a predefined role for read-only access for remote support, you can use the role

SAP RCA SAT DISP.Itisavailableinthe STPI plug-inand is generated when a managed system is connected to
SAP Solution Manager.
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A Appendix

Al Appendix

A.1l.1 Related Guides

For more information about installation and configuration, see the Master Guide.

A.1l.2 Related Information

The following table contains links to information related to the Application Operations Guide.

Table 14:

Content

Master Guide, Installation Guide and Upgrade Guide

Quick Link on SAP Service Marketplace

http://service.sap.com/instguidessr

Related SAP Notes

http://service.sap.com/notes

Released Platforms

http://service.sap.com/platforms

Network Security

http://service.sap.com/securityguide P

http://service.sap.com/network

Technical Infrastructure

http://service.sap.com/installNW74 ¥

SAP Solution Manager

http://service.sap.com/solutionmanager #ir
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Important Disclaimers and Legal Information

Coding Samples

Any software coding and/or code lines / strings ("Code") included in this documentation are only examples and are not intended to be used in a productive system
environment. The Code is only intended to better explain and visualize the syntax and phrasing rules of certain coding. SAP does not warrant the correctness and
completeness of the Code given herein, and SAP shall not be liable for errors or damages caused by the usage of the Code, unless damages were caused by SAP
intentionally or by SAP's gross negligence.

Accessibility

The information contained in the SAP documentation represents SAP's current view of accessibility criteria as of the date of publication; it is in no way intended to be a
binding guideline on how to ensure accessibility of software products. SAP in particular disclaims any liability in relation to this document. This disclaimer, however, does
not apply in cases of willful misconduct or gross negligence of SAP. Furthermore, this document does not result in any direct or indirect contractual obligations of SAP.

Gender-Neutral Language

As far as possible, SAP documentation is gender neutral. Depending on the context, the reader is addressed directly with "you", or a gender-neutral noun (such as "sales
person" or "working days") is used. If when referring to members of both sexes, however, the third-person singular cannot be avoided or a gender-neutral noun does not
exist, SAP reserves the right to use the masculine form of the noun and pronoun. This is to ensure that the documentation remains comprehensible.

Internet Hyperlinks

The SAP documentation may contain hyperlinks to the Internet. These hyperlinks are intended to serve as a hint about where to find related information. SAP does not
warrant the availability and correctness of this related information or the ability of this information to serve a particular purpose. SAP shall not be liable for any damages
caused by the use of related information unless damages have been caused by SAP's gross negligence or willful misconduct. All links are categorized for transparency
(see: http://help.sap.com/disclaimer).
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